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Abstract 

This document contains EP6 help information and a set of scripts to allow users to walk-through 
the EP6 functionality. EP6 will be released for evaluation on November 27, 1995; the evaluation 
will continue through to January 31, 1996. The data analysis of the usability testing, the survey, 
and the comparison between the two will each be summarized in a chapter of the EP6 Evaluation 
Results Report, to be published by the end of February, 1996. 
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1. Introduction 

1.1 Purpose 

This paper describes background material on Evaluation Package 6 (EP6), EP6 Help information, 
and the scripts that science users can use to exercise the functionality of Evaluation Package 6 
across the following areas: 

User Registration

Desktop/Workbench

Earth Science Search Tool (ESST)

Linkage between the ESST and the Advertising Service

Advertising Service

Data Dictionary

User Profile Tool

Trouble Ticketing Tool

EOSView

User Preference Tool

Comment Survey Tool


The information in the scripts is presented in an Action and Response format. Action the user 
should take is followed by the system response to that action. 

1.2 Organization 

This paper is organized as follows: 

Chapter 2: EP6 background material 

Chapter 3: EP6 Help information 

Chapter 4: Science-user scripts 

Questions regarding technical information contained within this Paper should be addressed to the 
following ECS and/or GSFC contacts: 

• ECS Contacts 

– Naveen Hota, EP6 Manager, (301) 925-0542, nhota@eos.hitc.com 

– Janice Poston Day, EP6 Usability Test Lead, (301) 925-0811, jposton@eos.hitc.com 
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Questions concerning distribution or control of this document should be addressed to:


Data Management Office

The ECS Project Office

Hughes Information Technology Systems

1616 McCormick Drive

Upper Marlboro, MD 20774


1-2 160-TP-008-001




2. Evaluation Package Background Material 

2.1 Evaluation Package Overview 

The ECS Team has defined a multi-track development approach that includes an incremental 
development track that will build the full functionality of portions of the ECS in parallel with 
formal-track development of other portions of ECS. Evaluation Packages are the early delivery 
mechanism that allows portions of ECS functionality (incremental and prototype) to be placed in 
the hands of selected users for evaluation and design iteration in advance of formal system 
releases. Evaluation Packages bring together increments and prototypes for deployment and 
evaluation 

The feedback from one EP influences the objectives and design for the next. Each EP builds 
upon and expands the capabilities of previous EPs, until the last EP in the series supporting a 
formal release, when the software is migrated to the formal track for integration, acceptance 
testing, and formal delivery. Each EP may incorporate selected prototyping efforts from the ECS 
segments. Prototypes are selected for inclusion in an EP primarily based upon their function and 
content and their relation to the goals of the EP, and on their need for evaluation by multiple 
users in the community. 

2.2 Previous Evaluation Packages 

Evaluation Packages 1 through 3 were focused primarily on establishing a distributed testbed 
environment that interconnected ECS workstations at each DAAC and the ECS development 
facility in Landover, MD. The testbed environment is built upon an emerging communications 
technology, Open System Foundation's (OSF) Distributed Communications Environment (DCE). 
Evaluation Package 3 also introduced mockups of early concepts for the ECS Client. 

Evaluation Package 4 explores new concepts for the ECS Client based on the revised architecture 
presented at the ECS System Design Review in June 1994. In particular, Evaluation Package 4 
focuses on the Scientist Workbench; search and traversal of advertisements available from the 
Advertising Service; continued development of EOSView, an ECS tool for viewing Hierarchical 
Data Format (HDF) data; and continued development of selected communications infrastructure 
components. 

2.3 Evaluation Package 6 

Evaluation Package 6 expands on the prototypes included in EP4 and brings in new concepts 
developed during the Prototype Workshop 1 (PW1) held after EP4 and prior to EP6. The EP6 
Client is a combination of Xmotif and HTML-based application; a combination used for two 
reasons: 1) leverage users familiarity and acceptance of WWW viewers, and 2) demonstrate 
advanced X-windows capabilities currently out of scope for HTML functionality. 
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The EP6 Client contains many of the elements from EP4 including an updated Scientist’s 
Workbench, referred in this document as the Desktop/Workbench, an improved and expanded 
Advertising Service, and the latest version of EOSView. In addition, EP6 includes applications 
first exhibited at PW1 in May 1995. The Earth Science Search Tool, a comprehensive tool for 
ordering earth science data has been prototyped in Xmotif for EP6. The Data Dictionary and the 
User Registration tool have are also included. New tools such as the User Profile Tool and the 
User Preference Tool are available for evaluation in EP6 along with a Maintenance and 
Operations prototype of the Trouble Ticketing Tool. 

For a further description of EP6 functional content and physical configuration, consult the 
following: 

•	 EP6 Design Review Presentations 
(http://edhs1.gsfc.nasa.gov:8001/waisdata/toc/pp7220701toc.html) 

• ECS Evaluation Packages Strategic Plan - EP6 Version (222-WP-003-001) 

2.4 The Future 

Prototype Workshop 2 (PW2) is planned for January 23-25, 1996 and will build on some of the 
early lessons learned from EP6. The focus of PW2 is to investigate alternative ECS Client 
interfaces. It will showcase new developments in the Xmotif version of the ESST, a Web with 
Java version of the ESST as well as other Web and prototyped versions. Following PW2 is the 
EP7 scheduled for delivery in mid-1996. It is planned to contain prototypes of coincidence 
searching, hypertext authoring, metadata search capability, and subscription services. 
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3. Evaluation Package 6 Help Information 

This guide provides an overview of the capabilities of the Evaluation Package 6 (EP6) and 
describes how to access, display, and use those capabilities. 

3.1 User Registration 

Introduction 

The EP6 User Registration Tool allows non-ECS users to request an ECS account. Users with an 
ECS account have full access to the services which are provided for EP6. In addition, the tool 
also gives registered users the ability to make any necessary changes to their existing user 
profile. Guest users can gain access publicly from the World Wide Web, or from the ECS 
Desktop. Registered users may also gain access from any of the EP6 applications. 

Creating an ECS Account 

- Request 

To request an ECS account and obtain privileges beyond those of a guest user, you must 
complete the registration form by entering, as a minimum, your first name, last name and 
e_mail address. It is recommended that you also complete the mailing address section for 
it will speed up the registration process. To move around to the different text fields you 
can either click on that specific field or use the "tab" button on your keyboard. If any of 
the required fields are not completed, an error message will appear after the "submit" 
button is pressed notifying you that the required information was not completed, so be 
sure that all required information is provided. 

- Confirmation 

Once you have entered the required information you can either click "submit" to start the 
registration process or click " reset" to start over. If you click on "submit" the User 
Registration Confirmation page will pop up. This page reflects all of the information that 
was entered on the previous page. Once you have confirmed that your information is 
correct, then click "submit" again. If changes need to be made you can edit them on this 
screen before submitting. 

- Submittal 

Once you have clicked "submit" on the confirmation page, a screen will appear notifying 
you of the status of your submittal. If your submittal is a success, your information will 
be passed to the ECS User Account Management Server for processing. Upon successful 
completion of the registration process, for security purposes, your USERID and 
PASSWORD will be sent by US. mail. 
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3.2 The Login Window 

When the EP6 is started the login window will appear. The Welcome text in the scrolling 
portion of the login window provides information about the EP6 and its contents. 

1. Enter a login name in the Login field. Hit return to send the cursor to the Password field. 

2.	 Enter a password. If the Login name ecsGuest was entered in the Login field, a password 
is not necessary. 

3.	 Selecting the Begin button or hitting return in the Password field will start the user 
verification procedure. 

User names and passwords will be provided by ECS. 

3.3 The Desktop/Workbench 

General Description 

The ECS desktop provides a general framework for organizing and presenting various 
application objects (data and programs) with which a user interfaces. The desktop application 
will display a directory in two different formats. 

- Iconic Format - all files and applications are represented by their icons on the Desktop 

- Hierarchical Format - files and applications are organized alphabetically on the desktop. 
The contents of directories can be opened and displayed in the same Desktop/Workbench 
window. This method of display is similar to that of the Macintosh operating system. 

Desktop Application windows display sets of icons, each of which represents a specific data file, 
directory or an application. Each icon will have one or more actions related to it. These actions 
can invoked from the Actions pull down menu. These actions can be performed by: 

- Selecting an icon, then selecting the menu option for the particular action. 

- Double-Clicking on an icon. 

- Dragging an icon onto another icon or another window using mouse button-2. Drag & 
Drop is supported for Directory icons and EOSView Icons for EP6. 

After a user login has been verified the Desktop/Workbench window will appear. If the user 
logged in as ecsGuest then the User Registration Tool will appear within a WWW browser 
window. 

To register a guest user with ECS: 

Enter the requested information into the fields within the User Registration Tool window. 
Confirm and submit this information to ECS. NOTE: entering this information will not 
automatically register the user with ECS and allow them access to registered user 
privileges. Contact Jan Poston Day (jposton@eos.hitc.com) for account information 

The Desktop/Workbench pull-down menus contain tools for use in EP6 and actions appropriate 
to activate those tools, as well as tools for file management. 
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• File: 

Delete Item - Click on an item and click on File/Delete Item to delete an item on 
Desktop. You will get a warning message to confirm the item to be deleted. Applications 
cannot be deleted. 

Close - Closes the current Desktop Window. Exits the desktop application on closing the 
last window. 

Exit - Exits all windows of Desktop. 

• Directory: 

Create Directory - Creates a directory in the current directory. Prompts the user to enter a 
name for the directory. 

Home - Displays contents of the directory '$HOME/.ecs' in the current Desktop Window. 

Up - Go to parent Directory. 

Hierarchical Directory Listing - Open a new window with contents listed in Hierarchical 
format. This option is grayed out when in Hierarchical format. 

Iconic Directory Listing - Open a new Window with contents listed in Iconic format. This 
option is grayed out when in Iconic format. 

Refresh - Refreshes the current Window. 

• Tools: 

Comment Survey - access to the EP6 Comment Survey through a WWW browser 

User Registration - access to the EP6 User Registration Tool through a WWW browser 

User Preference Tool - access to the EP6 User Preference Tool 

ECS Data Handling System (EDHS) - access to the ECS Data Handling System where 
users can link to information about ECS and EOSDIS through a WWW browser 

User's Recommendations (URDB) - access to the WWW interface of the ECS User 
Recommendations Database, the ECS "suggestion box" 

• Action: 

OpenNewWindow - This action is a default action for a Directory. Opens a new window 
with contents of selected directory. 

OpenInPlace - Show the contents of selected directory in the same window. 

Open - This action is used for both application and documents (or data files). If the 
selected icon is an application, it open (or executes ) an application. If the selected icon is 
a data files, it opens the data file using related application. 

Animate - This action is used to animate the selected image file. 
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• Help: 

On EP6 - access to help about EP6 through a WWW browser 

On Application - access to help on a particular application within EP6 through a WWW 
browser 

3.4 The Earth Science Search Tool (ESST) 

3.4.1 Introduction 

The Earth Science Search Tool (ESST) provides the means for finding, examining, and ordering 
Earth Science Data Collections and granules. A three step paradigm has been developed to keep 
the process simple. These steps are: (1) Entering a search and submitting it, (2) reviewing results 
returned from an ECS database, and (3) selecting specific results for shipment to the client. 
While this process has been designed for optimum usability, sufficient flexibility exists for the 
addition of advanced capabilities for users with sophisticated requirements. The process is 
described in detail in the descriptions of each Earth Science Search Tool screen. 

To access the ESST you may either double click on the ESST icon or click once on the icon and 
then return to the Action pull-down menu and select Open. The ESST window will appear 

The First Step, entering a search and submitting it, is performed on the Search Summary Screen. 
This screen is the first to appear when the Earth Science Search Tool is invoked. It contains the 
following items: menu bar, icon selection tool button, search type selection button, icon tool bar, 
Temporal summary area, Spatial summary area, and Discrete Attribute summary area. 

A Search is a set of constraints selected for one or more attributes. These constraints are selected 
by clicking the icon buttons shown in the icon tool bar followed by selection of the specific 
constraint. The means of selection depends on which type of attribute was selected. For the 
temporal attribute, a timeline is displayed, from which a time range may be selected. For the 
spatial attribute, a geographic map is displayed, from which a rectangular region of interest may 
be selected. 

For attributes with only a few discrete choices to select from, a pull-down list appears, from 
which a selection may be easily made. For attributes with many discrete choices to select from, a 
dialog window with a convenient find feature will be displayed. In general, the display which 
appears following selection of an icon button depends upon the type of the corresponding 
attribute. Note that temporal ranges selected will be shown in the temporal summary area, spatial 
regions in the spatial summary area, and all attributes summarized in textual format in the 
discrete attribute summary area. 

After a search has been entered, it may be submitted to the ECS database for processing by 
clicking the "Submit Search" button. The current query attribute values can be saved for future 
use by selecting "Save" or "Save As" from the "Search" menu. The "Collection Hits" field, at the 
bottom of the screen, shows the number of collections searched when a query is made. After a 
search is submitted, a modal dialog gives the user an estimate of the amount of time it will take 
to complete the search. The user can cancel the search by clicking on the "cancel/quit" button in 
the dialog. 

3-4 160-TP-008-001




The Menu Bar for the Search Summary Screen contains the four following items: "Search", 
"Edit", "Options", and "Help". When the "Search" button is clicked, a pop-up menu appears with 
the following items: 

• Search: 

Open - accesses a list of files which may be retrieved. 

Save - automatically saves the open file under its existing name. 

Save As - opens a window with the option to save the open file under a name specified at 
this time. 

Quit - closes the Earth Science Search Tool application. 

When the "Edit" button is clicked, a pop-up menu appears with the following items: 

• Edit: 

Undo Action - reverses the last change made to the search 

Delete Attribute/Value - deletes a specific marked attribute or value 

Clear Attributes - clears all of the present attributes selected in the open file 

When the "Options" button is clicked, a pop-up menu appears containing the following items: 

• Options: 

Change Icon Bar - opens a window with the option to configure a new personally selected 
set of icons for the icon bar. 

Set Preferences - opens a window containing all of the personal preferences that can be 
chosen in regards to the Earth Science Search Tool. 

Finally, the "Help" menu contains the following items: 

• Help: 

Table of Contents - opens a list of all items in the help menu 

This Screen. - opens the help page for the open screen of the application Data Dictionary 

Introduction - brings up the help page introduction to the Earth Science Search Tool 

The "Search Type" selection button, located below the menu bar, provides advanced features in 
assisting users with their search query. Users can search on the Advertising Service, The Data 
Dictionary, or Guide information by selecting the item of interest and specifying search criteria 
by selecting them from the icons in the attribute icon tool bar below. 

3.4.2 The Attribute Icon Selection Tool 

The Attribute Icon selection Tool is a non-modal dialog that allows the user to customize both 
the icon tool bar in the ESST main window and the metadata displays in the Search Results and 
Product Request Confirmation windows. 
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To start the tool click on the Attribute Icon Selection Tool from the options menu or click on the 
short-cut button. Icons can be selected for display in any of the above windows by either 
dragging the appropriate icon from the "Available Attributes" region to the "Attributes" region or 
by selecting the desired icon and clicking the "Add" button. To delete icons from the Attributes 
region, drag the icon from the Attributes and drop the icon outside the region, or select the icon 
and click on the "Delete" button. 

To save the current set of attributes, click the "Save Set" button. To open saved sets, select the 
set from the "Attribute Set" pop-up menu that appears when the "Attribute Set" icon is clicked. A 
set can be deleted from the "Attribute Set" pop-up menu by selecting the set and clicking the 
"Delete Set" button. By clicking the "Apply" button, the current icon set replaces the set 
currently used in the window indicated by the "Applied Window" pop-up display. 

3.4.3 The Search Results 

The Second Step, reviewing the results of the search, is performed on the Search Results Screen. 
When a search has been submitted and is complete, the data server sends back all of the 
collections and granules which match the search criteria set in the search summary screens. From 
this point, the user can browse, view coverage and detail information, and select additional data 
server processing for granules or collections. 

In order to perform any of the three above operations, mark the checkbox for that particular 
granule or collection under the appropriate icon in the Services section of the screen. If a 
checkbox is not shown, then that service is unavailable for that particular granule or collection. 
Marking a collection, marks all of its granules as well. 

To Browse, View, or Process the marked data, click the respective icon in the Services section. 
Clicking on the Preview Order button sends the items marked for order to the Product Request 
Tool for confirmation and order submittal. 

3.5 The Product Request Tool 

The Product Request Tool is an extension of the Earth Science Search Tool that allows users to 
confirm that selected data collections and/or granules are to be ordered. It also allows the user to 
utilize many different options before submitting their order. This help page will explain those 
options and how to submit an order. 

The Product Request Tool can be launched from the "Search Results Screen" of the Earth 
Science Search Tool. The same tools that were available in the Search Results screen may be 
used again for performing tasks on granules or collections on this screen. The same information 
that was returned to the Search Results screen will also appear here. At this point, the may, again, 
browse, view coverage and detail information, and select additional data server processing for 
granules or collection. Marking the Checkbox for a the specified granules or collections will 
allow you to perform these tasks. If a checkbox is not shown, then that service is unavailable for 
that particular granule or collection. Marking a collection, marks all of its granules as well. 

The Summary section at the bottom of the page gives the user information on the granules and/or 
collections that were selected. Categories shown are Total Price, Media Type, Media Format, and 
Mailing Address. Once the user is satisfied with their selections, the "Submit Order" button may 
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be clicked. As the order is being processed, the user will receive an E-mail message stating that 
their order was received along with further instructions. 

3.6 The Advertising Service 

The Advertising Service facilitates collaborative research by allowing scientists to directly 
advertise and exchange their datasets, software tools and services. The Advertising Service 
allows for text searching on advertisements. Some of these advertisements will be services which 
may simply provide contact information with which users can follow-up on and gain access to 
information of interest. Other services will lead users directly to the data, tool or service 
advertised. 

The full ECS system will be fielded in a series of releases beginning in December of 1996. For 
ECS documents and project related information please see the ECS Data Handling System. For 
informal information please see the ECS Science Office Home Page. 

With the Advertising Service, users can navigate Earth Science related aspects of the World 
Wide Web (WWW) in a user friendly way. This feature is similar to a "yellow pages" in a phone 
book but unlike the phone book, the Advertising Service is dynamic and provides more 
information than a phone listing. Although it is like current WWW search engines, the 
Advertising Service returns more than just a list of URLs that match the users' search criteria. 
The Advertising Service returns a list of URLs and a description of each advertised home page 
matching the users' search criteria; the user can read the description and related information 
before linking to the page. 

The purpose of the Advertising Service is to provide a means of managing service, provider, and 
data advertisements within the Earth Science Community. A unique aspect of the Advertising 
Service is that users are allowed and encouraged to contribute to the Advertising Service by 
advertising their data, services, or provider information. A user submits an advertisement by 
providing the title, description, and other pertinent information about the service/provider. Once 
the advertisement is submitted it is immediately searchable through the Advertising Service. 

When a user searches for all links related to, for example, drought in Iowa, USA, the Advertising 
Service would return the URLs and their descriptions which satisfy the criteria, services available 
on that data, and providers who can help the user access the data. This is a significant 
advancement over the currently a available search engines, they do not provide the descriptive 
information that the Advertising Service does. 

3.7 The Data Dictionary 

The Data Dictionary Tool provides access to databases containing information on Earth Science 
related data. It consists of a glossary of ECS terms and data, an expanded ECS Acronym list, 
information on EP6 Data Collections, Instruments, Parameters, Platforms, and Archive Sites. 
Users will be able to access the Data Dictionary Tool publicly from the World Wide Web, from 
the ECS Desktop, and from any of the EP6 applications (i.e., the Earth Science Search Tool). 
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Searching for Information in the Data Dictionary 

There are different ways of accessing and retrieving information from the Data Dictionary. The 
user may choose to search by either scrolling through the Index or by entering a keyword into the 
"search" text field of the Search Form. 

• Simple Search Form 

With this form the user can enter one or more keywords into the text field to be searched. 
Most frequent used search options are set as defaults for quick search. If you would like 
to change the default settings, please use Full Search Form. 

• Full Search Form 

Using "Full Search Form", users are able to change category and search options. More 
details on the search options can be found under Searching Hints. 

• Index 

The Index contains a listing of searchable categories. Currently there are eight categories 
populated with data in the ECS Data Dictionary server. They include: Acronyms, Data 
Collection, Glossary, Instrument, Parameter Group, Parameter Topic, Platform and Site. 
In addition to the above, a special category, ALL, contains the complete list of items in 
the ECS Data Dictionary holding. 

• Search Form vs Index 

Search Form is more powerful and flexible than the Index. However, it may take longer 
to get the search results, if the search query is too broad. Or, it may get no hits, if no 
matches are found in the database. On the contrary, by following the links through Index, 
performance is better and results are guaranteed. 

3.8 The User Profile Tool 

The User Profile tool facilitates modification of user information for any registered ECS user. 
The information will be stored in the User Information Database which is controlled by MSS. 
Centralized, remote storage and access of this information will allow context retrieval 
(restoration of the users' profile information) on any client to which the user logs in. 

If a registered ECS user wants to retrieve their profile for updating purposes, they must first click 
on the User Profile Icon from the ECS desktop. The User Profile tool will automatically 
recognize the USERID of the current user and retrieve the respective profile. The user may now 
make any necessary changes to their profile information by clicking in the desired field and 
inputting new information. To submit the new profile the user must click the "submit" button at 
the bottom of the page. The updated information will then be submitted to User Information 
Database, replacing the users previous profile. 

NOTE - Once the user has submitted a new profile, all information on the previous 
profile is overridden and cannot be retrieved. 
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NOTE: The same form that is provided for the mailing address will also be provided for 
the Billing and Shipping address so the user may enter three different addresses for the 
respective fields. 

3.9 The Trouble Ticketing Tool 

The Trouble Ticketing Service is an application that allows users who encounter problems with 
any of the EP6 applications to submit a trouble ticket through a provided HTML form. A 
common environment for classifying, tracking and reporting on problem occurrence and 
resolution will be provided. Users that submit trouble tickets will be notified on the status of the 
ticket via e-mail generation. 

To submit a Trouble Ticket: 

1. Click the "Trouble Ticketing Service" icon from the ECS Desktop. 

2.	 From the Trouble Ticketing home page click the "Submit a Trouble Ticket" link located 
under the "Menu" subtitle. 

3.	 From the "Submit a Trouble Ticket" screen you will see a table (unless using Mosaic) 
displaying user information: ID, name, E-mail address and phone number. Below the 
"User Information" table is the "Problem Information" table. 

The Problem Information table contains three sections: 

A. Impact - Click on Low, Medium, or High to describe the impact of the problem. 

B. Short Description - Give a short, one line, description of the problem. 

C. Detailed Problem Description - Give a detailed description of the problem. 

4.	 Once the problem information has been entered, click the submit button to send the 
Trouble Ticket to the ECS database. Once this is achieved a trouble ticket number will 
be assigned. As the problem is worked, an e-mail message will be sent regarding its 
status. 

3.10 EOSView 

EOSView is an HDF file verification tool. The contents of an HDF file are displayed and 
individual objects can be selected for display. Displays include raster Images, datasets in tables, 
pseudocolor images of datasets, attributes, and annotations. Simple animations can be performed 
for a file with multiple raster images. 

1. Current workstation availability: 

SUN - Solaris 2.3 (SunOS 4.1.3 due soon!), IBM - AIX 3.2.5, HP - HPUX 9.03/9.04, SGI - IRIX 
5.2, DEC - OSF/1 V2.0 

2. Main Features: 

a) Display of HDF file contents, b) Raster Image display, c) Raster Image animation, d) 
Display of SDS data in table, e) Display of Vdata in table, f) Opening of Vgroup for display, g) 
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Pseudocolor display of SDS data, h) Palette selection, i) display of text objects, j) Hypertext 
help 

•	 To Open an HDF file, select the File-Open selection from the menu bar on the EOSView-
EOSView Main Window. This will cause a file selection dialog to appear. Once a file 
has been selected for viewing the contents of that file will appear in an EOSView File 
Contents Window. 

•	 To select an EOSView window and have the focus change to that window select the 
Window option from the menu bar. The pull-down window will contain a list of 
EOSView window titles. Select the title of the desired window. 

• 	 To exit EOSView select File-Exit selection from the menu bar on EOSView-EOSView 
Main Window. 

3.11 The User Preference Tool 

This tool allows users to change or update any configurable items for each of the Desktop tools. 
For each tool there is a unique set of configurable items. These items are set to default values 
when the application is first used. Once items have been configured they may be saved for all 
future interactions. 

One of the items the User Preference Tool allows users to set is their World Wide Web (WWW) 
browser of preference. The default browser setting for EP6 is Mosaic, however it is 
recommended that Netscape Navigator be used. When selecting Netscape as their default 
browser, it is recommended that users type “netscape -install” in the appropriate field within the 
preference tool. This command helps to alleviate some of the Netscape color mapping resource 
limitations. 

3.12 The Comment Survey Tool 

The Comment/Survey Tool offers a means for EP6 users to give useful feedback to developers in 
an effort to build a better product. For each EP6 application there will be a series of statements 
concerning the overall performance of the particular application with which the user may either 
agree or disagree with. There will also be a section provided for users to enter their own 
comments concerning the application. 

Using the Comment/Survey Tool: 

To start the Comment/Survey Tool, click on its icon from the EP6 Homepage or from the ECS 
Desktop. The front page contains a brief description of what the Comment/Survey Tool is and an 
index of questionnaires for each of the EP6 applications. Also included in the index is a general 
questionnaire to evaluate the performance of the entire EP6 package. 

For each questionnaire there are a series of statements concerning the particular application in the 
middle column. To the right of those statements are the numbers 1 to 5, 1 = strongly disagree, 
5 = strongly agree. Simply click the appropriate number for each of the corresponding 
statements. If the user wants to make any comments he/she can do so by typing in the text input 
area located at the bottom of the questionnaire. 

3-10 160-TP-008-001




When the questions have been completed, the user may click the submit button at the bottom of 
the page to send the survey to an ECS database, or, if they are not satisfied with the their 
answers, they may click the reset button to begin again. 
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4. Science-User Scripts 

The following scripts have been organized such that a user can proceed step by step through each 
portion of EP6 to exercise EP6 functionality. Each exercise script is organized so that the action 
the user can take is paired with the system response to that action. 

4.1 User Registration 

Table 4.1. Script to Exercise the User Registration Tool 
Step Action Response 

1 Login to EP6 using ecsGuest as your 
login name. No password is required. 

User Registration form will appear in WWW 
browser window. 

2 Select "Applicant's Information" A table containing fields to fill out will appear. 

3 Type in your user registration information The fields marked with a red √ mark are mandatory 
fields, they must be filled in for ECS to accept the 
user's registration. 

4 Click the "Submit" button to send your 
registration information to ECS 

The ECS User Registration Confirmation screen will 
appear. 

5 Confirm that the information you typed 
into the fields is correct and click the 
"Submit" button 

The status of your user registration is displayed 
informing you that your registration information has 
been submitted to ECS and that your user account 
information and password will be sent to you via US 
Mail. 

This concludes the script to exercise the 
User Registration Tool. 

4.2 Desktop/Workbench 

Table 4.2. Script to Exercise the Desktop/Workbench (1 of 2) 
Step Action Response 

1 Examine the contents of the pull-down 
menus. 

The pull-down menus open as the cursor moves 
across them. 

2 Examine the EP6 Help by selecting the 
Help pull-down menu 

The Help information is displayed in a WWW 
browser window. 

3. After examining the Help information 
return to the Desktop/Workbench 
“Directory” pull-down menu and select 
“Create directory.” 

The File menu opens, “Create directory” is 
highlighted. A dialog box appears. 

4 In the dialog box field type “Advert_links” 
and press “OK.” 

The dialog box disappears and the folder entitled, 
“Advert_links” appears on the Desktop/Workbench. 
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Table 4.2. Script to Exercise the Desktop/Workbench (2 of 2) 
Step Action Response 

5 Double-click on the new folder, or highlight 
the icon, go to the “Action” pull-down menu 
and select “OpenInPlace.” 

The Desktop/Workbench window refreshes and 
displays the contents of the “Advert_links” folder 
within the refreshed window. One icon, “..(go up)” 
is shown. 

6 Return to the previous level of the 
Desktop/Workbench by double-clicking on 
the “..(go up)” icon. 

The window refreshes and displays the previous 
level of the Desktop/Workbench with all of the EP6 
applications as icons. 

This concludes the script to exercise the 
Desktop/Workbench 

4.3 Earth Science Search Tool (ESST) 

Table 4.3. Script to Exercise the Earth Science Search Tool (ESST) (1 of 3) 
Step Action Response 

1	 Double-click on the Earth Science Search The ESST window appears 
Tool (ESST) icon on the Desktop 

2	 Formulate a query for data by selecting A pull-down menu listing all the EP6 supported 
search criteria. Begin by selecting a sensors appears. 
Sensor, click on the Sensor icon. 

3 Select AVHRR by clicking on the text	 The text "AVHRR" appears in the area labeled 
"Discrete Attribute Summary" beneath the 
heading "sensorShortName" and the pull-down 
menu disappears. 

4 Select a search parameter by clicking on A pull-down menu listing all of the valid EP6 
the Parameter icon. supported parameters appears. The 

parameters that are not valid, because AVHRR 
was selected as the sensor, are greyed-out. 

5 Select NDVI by clicking on the text	 The text "NDVI" appears in the area labeled 
"Discrete Attribute Summary" beneath the 
heading "parameter Topic" and the pull-down 
menu disappears. 

6 Define the temporal bounds of the search The Timeline Tool appears on the screen. The 
by clicking on the Temporal icon datasets supported by EP6 are shown within 

the Timeline. 

7	 To view the temporal coverage of data The Timeline Tool display scrolls forwards and 
within EP6 move the scroll bar at the backwards from 1986 to 1992. 
bottom of the Timeline Tool 

8	 Select the time range 6/1/1992 to A yellow highlight box appears over the 
6/30/1992 by highlighting that portion of dataset entitled, "1KM-NDVI" 
the timeline with your cursor. Note: it 
may be difficult to select the exact dates, 
try to get as close to them as possible. 
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Table 4.3. Script to Exercise the Earth Science Search Tool (ESST) (2 of 3) 
Step Action Response 

9 Close the window by clicking on the 
Update/Close button 

The Timeline Tool window will close and the 
start and end dates selected will appear in the 
"Discrete Attribute Summary" beneath the 
heading "Temporal." 

10 Submit the Search by clicking on the 
“Submit Search” button at the bottom of 
the window. 

The results of the search are returned and 
displayed in a "Search Results" window. 

11 Open the data collection to reveal the 
granules returned by the search. To 
open the data collection click on the file 
folder icon to the left of the data collection 
name, “1KM-NDVI.” 

The granules are displayed. 

12 Select a browse image to view by clicking 
in a white box in the "Browse" column. 
To access the browse image then click 
on the "Browse" icon at the top of the 
column. 

A User Profile dialog box is displayed. 

13 Fill in the requested information in the 
dialog box : 
• e-mail address: enter the address using 

EP6 login name@ the machine 
containing the client. 
ex. jposton@epserver.gsfc.com 

• Destination directory: the same as the 
directory/path information located on 
the Desktop/Workbench beneath the 
pull-down menus. 
ex: /users/jposton/.ecs/ 

• Your Host Password: the password you 
use to login to EP6 

• Your Host Name: the server on which 
the EP6 client is running. 
ex: epserver.gsfc.nasa.gov 

click "OK" when you have finished 
entering the information. 

The System will retrieve the browse image 
from the database and automatically start up 
EOSView and load the browse image into 
EOSView for visualization. 
To view the image - continue with the exercise 
of EOSView step 2. 
To continue exercising the ESST see the next 
step. 

14 Select the boxes in the "Select to Order" 
column by clicking on the data granules 
of interest. 

Check marks will appear in the boxes in the far 
left-hand column. 

15 Click the "Preview Order" button at the 
bottom of the window 

The "Product Request Tool" window appears 
containing a summary of the order. 

16 Confirm that the information is correct. 
Change the media type to “ftppull.” 
Submit the order by clicking the "Submit 
Order" button. 

The dialog box disappears when the data has 
been stored in a directory for pickup. An email 
notification will be sent to the user with the 
name and location of the data that was 
ordered. 
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Table 4.3. Script to Exercise the Earth Science Search Tool (ESST) (3 of 3) 
Step Action Response 

NOTE: if “ftppush” was selected in the 
previous step, the user profile information 
filled out, and the order submitted, the 
user would receive an email notifying 
them that the information was stored in 
the directory they requested in their 
account. To ensure that the data would 
be sent to your Desktop/Workbench type 
your home directory path ending with .ecs 

17 When the order has been completed you 
may close the ESST and Product 
Request Tool windows and return to step 
2 to do another search. 

This concludes the script to exercise the 
Earth Science Search Tool. 

4.4 Linkage Between the ESST and the Advertising Service 

Table 4.4. Script to Exercise the Linkage Between the ESST 
and the Advertising Service (1 of 2) 

Step Action Response 

1	 Access the ESST by double-clicking on The ESST window appears 
the ESST icon in the Desktop/Workbench 

2	 Select "Advertising" from the "Search The word "Advertising" appears in the pull-down 
Type" pull-down window located beneath menu selection 
the ESST pull-down menus at the upper 
left of the window 

3	 Formulate a query for data in the A pull-down menu listing all the EP6 supported 
Advertising Service by selecting search sensors appears. 
criteria. Begin by selecting a Sensor, click 
on the Sensor icon. 

4 Select AVHRR by clicking on the text	 The text "AVHRR" appears in the area labeled 
"Discreet Attribute Summary" beneath the heading 
"sensorShortName" and the pull-down menu 
disappears. 

5	 Submit the search to the Advertising The Advertising Service will appear in a WWW 
Service by clicking the "Submit Search" browser window. The results of your search will 
button at the bottom of the ESST window. appear in the “Search Results” page. 

6 Select the highlighted text and review the A detailed description of the Service is displayed 
advertisement along with the service URL, the date the service 

was submitted, the organization/mission category, 
a contact point for users and an email address. 
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Table 4.4. Script to Exercise the Linkage Between the ESST 
and the Advertising Service(2 of 2) 

Step Action Response 

7 To continue exercising the Advertising 
Service from this point, refer to step 3 of 
the Advertising Service exercise script 
below. 

This concludes the script to exercise the 
linkage between the ESST and the 
Advertising Service. 

4.5 The Advertising Service 

Table 4.5. Script to Exercise the Advertising Service (1 of 4) 
Step Action Response 

1	 Access the Advertising Service by double- The Advertising Service home page appears in a 
clicking on the Advertising Service icon on WWW browser window 
the Desktop/Workbench 

2 To learn more about the Advertising Detailed information about the mission and 
Service select the highlighted text "What implementation of the Advertising Service appears. 
is" on the home page. Links to other ECS-related home pages are 

available. 

3	 Return to the home page by selecting the The Advertising Service home page appears in the 
browser "back" button WWW browser window 

4 Click on the highlighted text, "Index" The Advertising Service Index page appears. 

5 Each typewriter key on the displayed page A listing of all Advertising Service holdings 
indicates the first letter of the alphabetical beginning with the letter "A" is displayed in the 
index. Select the letter "A" window. The entries are listed by their 

categorization: Product, Service, or Provider. 

6 Scroll down the list and select the Service A detailed description of the Service is displayed 
"Alaska Synthetic Aperture Radar Facility along with the service URL, the date the service 
Calibration" was submitted, the organization/mission category, 

a contact point for users and an email address. 

7 Click on the highlighted URL	 The Advertising Service links to the service's URL 
and the "ASF Calibration '95" page is displayed. 

8	 Return to the Advertising Service home The Advertising Service home page appears in the 
page by clicking back from the "ASF WWW browser window 
Calibration '95" page and clicking on the 
Advertising Service icon at the top of the 
window 

9 Select the "General Search" link	 The "Search Advertising Service" form is displayed 
in the window. 
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Table 4.5. Script to Exercise the Advertising Service (2 of 4) 
Step Action Response 

10 After reading the introductory text, type the 
words, "sea ice" and submit the search. 

A listing of all Advertising Service holdings with 
“sea AND ice" is displayed in the window. The 
entries are listed by their categorization: Product, 
Service, or Provider. 

11 Return to the "General Search" form using 
the browser “back” button and change the 
Search Options so that search uses a 
Boolean “OR” between words 

A listing of all Advertising Service holdings with 
“sea OR ice" is displayed in the window. The 
entries are listed by their categorization: Product, 
Service, or Provider. 

12 Return to the “General Search” form and 
change the Search Options so that the 
search also looks in the “description” of the 
Advertisement and increase the Maximum 
Results to “50” 

A listing of all Advertising Service holdings with 
“sea OR ice" in the title or description is displayed 
in the window. The entries are listed by their 
categorization: Product, Service, or Provider. 

13 Return to the Advertising Service Home 
Page and select “Attribute Search” listed 
under “Search Advertisements.” This form 
allows you to search for data products that 
correspond to the attributes you enter into 
the form. Enter the sensor name 
“AVHRR” and the coordinates: 
upper left longitude: -80 
upper left latitude: 40 
lower right longitude: -70 
lower right latitude: 30 
Submit the selected Attribute search by 
clicking the “Submit” button. 

A listing of all Advertising Service holdings which fit 
the attributes you entered are displayed. 

14 Return to the Attribute Search form using 
the browser “back” button to refine your 
search. Add a search attribute Parameter, 
“Sea Ice.” Submit the refined search by 
clicking on the “Submit” button. 

The listed displayed contains a short list of data 
products advertised within the Service. 

15 Select one of the Products from the list A description of the Product is available along with 
the associated contact information. Product 
Processing level, the associated Parameters, and 
the temporal and spatial coverage for the data 
product are provided. This information was 
downloaded from the Global Change Master 
Directory (GCMD), it is listed as the Organization 
which provided the advertisement. Because these 
have been downloaded from the GCMD they do 
not contain URLs. 

16 Return to the Attribute Search form to 
submit a new search. Clear all of the 
fields of text using the “Reset” button. 
Under Search Options, select “EOS” from 
the “Organization/Mission” pull-down 
menu. Submit your search. 

The Attribute Search returns 3 data Products listed 
on the Results page. 
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Table 4.5. Script to Exercise the Advertising Service (3 of 4) 
Step Action Response 

17 Select the “ISCCP_C2” Product 
Advertisement. Scroll down to the bottom 
of the page. 

The ISCCP_C2 Product Advertisement is 
displayed. Three buttons, “Install,” “Invoke,” and 
“Order” are shown. 

18 Click on the “Invoke” button The Advertising Service links to the Earth Science 
Search Tool and the ESST window opens. 

19 At this point you may search for the 
ISCCP_C2 Data Collection using the icons 
in the Attribute Tool Bar. 

To continue exercising the ESST please see step 
2 of the Script to exercise the ESST found above. 
Search for the ISCCP_C2 data collection by 
selecting the parameter “cloud type.” 
To continue exercising the Advertising Service see 
the next step in this script. 

20 Return to the ISCCP_C2 Product 
Advertisement displayed in the WWW 
browser window. Click on the “Install” 
button at the bottom of the page. 

A dialog box appears instructing you to type in the 
location where you would like the Product 
Advertisement link stored in your /home directory, 
and you may also re-name the Product 
Advertisement link. 

21 Check to see that your directory/path 
information is correctly listed in the 
“Filename” field. The name of the file 
follows after the “/.ecs/” portion of the text. 
You may rename the file by editing this 
portion of the field. 

The link appears as an icon on the 
Desktop/Workbench. 

22 Highlight the Advertisement and drag it on 
to the “Advert_links” folder you created on 
the Desktop/Workbench. 

The icon will highlight as it is dragged and dropped 
into the “Advert_links” folder. To exercise the 
Desktop/Workbench continue with step 5 of the 
exercise script for the Desktop/Workbench listed 
above. 
To continue in the Advertising Service see the next 
step of this script. 

23 Return to the ISCCP_C2 Product 
Advertisement displayed in the WWW 
browser window. Click on the “Order” 
button at the bottom of the page. 

The Advertising Service links to the Earth Science 
Search Tool and the ESST window opens. 

24 At this point you may search for the 
ISCCP_C2 Data Collection using the icons 
in the Attribute Tool Bar. 

To continue exercising the ESST please see step 
2 of the Script to exercise the ESST found above. 
To continue exercising the Advertising Service see 
the next step in this script. 

25 Return to the Advertising Service Home 
Page and select, “Advertisement 
Submission Form” 

The “Submit Advertisement” form appears in the 
browser window. 

26 In the fields provided, fill in the information 
to submit an advertisement for your DAAC 
or earth science-related page. When the 
form is complete click on the “Submit” 
button at the bottom of the page. 

The “Submission Result” window is displayed. 
If there are any error messages please return to 
the previous page and correct the information and 
repeat step 17. 
If there are no error messages the “Submission 
Result” window is displayed. 
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Table 4.5. Script to Exercise the Advertising Service (4 of 4 
Step Action Response 

27 Return to the Advertising Service Home 
Page and select, “General Search.” 

The Advertising Home Page is displayed 

28 Enter a search for the advertisement you 
just submitted. 

The “Search Results” page is displayed with the 
results of your search. 

29 Scroll down the list of results and select 
your own advertisement. It should have a 
“NEW” icon displayed next to the title. 
Select your advertisement and click on it. 

The Advertisement you just submitted is displayed. 

This concludes the exercise script for the 
Advertising Service 

4.6 The Data Dictionary 

Table 4.6 Script to Exercise the Data Dictionary (1 of 3) 
Step Action Response 

1	 Double-click on the Data Dictionary icon in The Data Dictionary appears in a WWW browser 
the Desktop/Workbench window 

2 In the Data Dictionary Search Form type The result appears in the WWW browser window. 
"AVHRR" and press the "submit" button There are three "hits." AVHRR reference category 

Acronym, AVHRR reference category instrument, 
and North America, 1 km AVHRR 10-day 
composite NDVI reference category Data 
Collection 

3 Click on the highlighted text "Acronym"	 The result "Advanced Very High Resolution 
Radiometer" appears in the window beneath the 
title "Acronym Item Information" 

4 return to the previous screen by clicking The Instrument Item Information appears. A 
the "back" button and click on the description of the AVHRR instrument, cross 
highlighted text "Instrument" references to Data Collections within EP6 and 

related Platform information is available from this 
page. 

5 Scroll down the page and click on the The Platform Item Information appears listing the 
related Platform information, "NOAA-10" platform acronym, related Data Collections, and 

Instruments. 

6	 Return to the Data Dictionary Home Page The Full Search Form appears in the WWW 
by clicking on the Data Dictionary icon at browser window. 
the bottom of the page, and select "Full 
Search Form" which is highlighted on the 
page. 

7 Type in "Normalized Difference" in the The results of the search are returned and 
search field displayed in the WWW browser window. There is 

1 "hit" in the results set. 
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Table 4.6 Script to Exercise the Data Dictionary (2 of 3) 
Step Action Response 

8 Return to the Full Search Form by clicking 
the browser "back" button. Change the 
Search Options so that the search finds 
matches in both entry "Name" and 
"Description." Submit search. 

The Full Search Form is displayed and the search 
options are changed. There are 2 search result 
"hits" in the results set 

9 Return to the Data Dictionary home page 
by clicking on the Data Dictionary icon at 
the bottom of the page 

The Data Dictionary Home Page appears in the 
WWW browser window 

10 Scroll down to the Data Dictionary Index 
and select "All" 

An alphabetical listing of each acronym, data 
collection, glossary, instrument, parameter group, 
parameter topic, platform, and site pertinent to EP6 
are listed. 

11 Return to the Index by clicking the browser 
“back” button, and select the topic 
"Acronym" 

The alphabetical listing of the acronyms in EP6 are 
returned in the WWW browser window. Each entry 
is highlighted and linked to the acronym definition. 

12 Return to the Index by clicking the browser 
“back” button, and select the topic "Data 
Collection" 

A listing of the 3 Data Collections stored in EP6 
appears. Each entry is highlighted and linked to 
more detailed information about that particular 
Collection. 

13 Return to the Index by clicking the browser 
“back” button, select the topic "Glossary" 
from the Index 

The Data Dictionary Index Listing for the Glossary 
appears in the window. The Glossary entries are 
listed alphabetically. Each entry is highlighted and 
linked to the entry definitions. 

14 Return to the Index by clicking the browser 
“back” button, and select the topic 
"Instrument" 

A list of the 5 instruments appears in a WWW 
browser window. The Instrument entries are listed 
in alphabetical order. Each is highlighted and 
linked to more information about that instrument. 

15 Return to the Index by clicking the browser 
“back” button, and select the topic 
"Parameter Group." 

A list of EP6 data parameters are shown in 
alphabetical order according to their parameter 
group. Each entry is highlighted and linked to 
more information about the parameter, related 
Data Collections and Parameter Topics. 

16 Scroll down the list and select "Land 
Processes." 

The description of Land Processes appears in the 
browser window and is cross referenced with a 
Data Collection and the Parameter Topic "NDVI." 

17 Return to the Data Dictionary Index by 
clicking on the Data Dictionary Home Page 
icon at the bottom of the window. Select 
"Parameter Topic" from the list. 

A list of parameters appears in the browser 
window. Each parameter is highlighted and linked 
to more information. 

18 Scroll down the list and select "Cloud 
Albedo" 

A definition of Cloud Albedo including 
measurement units, horizontal and vertical 
resolution, and range is returned in the browser 
window along with information on related Data 
Collections and Parameter Groups 
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Table 4.6 Script to Exercise the Data Dictionary (3 of 3) 
Step Action Response 

19 Return to the Data Dictionary Index by 
clicking on the Data Dictionary Home Page 
icon at the bottom of the window. Select 
"Platform" from the list. 

The Platform Item Information appears in the 
browser window listing the platform acronym, 
related Data Collections, and Instruments. 

20 Return to the Data Dictionary Index and 
select "Site" from the list. 

A list of all the DAAC sites appears in the browser 
window. Each site is highlighted and linked to 
more information about that site. 

This concludes the script to exercise the 
Data Dictionary 

4.7 The User Profile Tool 

This tool is not available to those using EP6 with a Guest account. 

Table 4.7. Script to Exercise the User Profile Tool 
Step Action Response 

1	 Access the User Profile Tool by double- A WWW browser appears containing the ECS 
clicking on the User Profile Tool icon found User Profile 
on the Desktop/Workbench. 

2	 Review the contents of each of the fields by The information will appear on the WWW page in 
scrolling through the window. Scroll to your the appropriate fields as you type. Once the 
Mailing Address and enter the correct information is submitted, the system will return 
information in the fields. When completed the information to you within a User Profile 
scroll to the bottom of the window and click Confirmation notice and ask you to confirm the 
on the "submit" button information. 

3 Confirm the information and click on the The system will provide a confirmation notice that 
"submit" button. the information you provided has been submitted 

to the Profile Management Server for update 

This concludes the script to exercise the 
User Profile Tool 

4.8 The Trouble Ticketing Tool 

This tool is not available to those using EP6 with a Guest account. 

Table 4.8. Script to Exercise the Trouble Ticketing Tool (1 of 2) 
Step Action Response 

1	 Access the ECS Trouble Ticketing Service A WWW browser window appears with the Trouble 
from the Desktop/Workbench by double- Ticket Service information displayed. 
clicking on the icon. 

2	 After reading the introductory information, The WWW browser window displays a brief set of 
select the highlighted text "Submit a instructions below which is your user information. 
Trouble Ticket." 
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Table 4.8. Script to Exercise the Trouble Ticketing Tool (2 of 2) 
Step Action Response 

3 Scroll down to the portion of the screen 
entitled, "Problem Information." Determine 
the level of impact of your trouble ticket by 
selecting one of the buttons (low, medium, 
high). Enter a short description of the 
problem, and a more detailed description 
below it. Submit the ticket to ECS by 
clicking on the "submit" button. 

Notification that your trouble ticket was received by 
the system will appear in the WWW browser 
window. Your entry will be assigned a trouble 
ticket tracking number and you will receive an 
email to confirm the status of your trouble ticket. 

4 To view the trouble ticket you just 
submitted, click on the highlighted text, 
"this Trouble Ticket" 

The trouble ticket will appear in the browser 
window. 

5 Return to the Trouble Ticket Service home 
page by clicking on the icon at the bottom 
of the page 

The Trouble Ticket Service home page will appear 

6 To view a listing of all of the trouble tickets 
you have submitted select, "List my 
Trouble Tickets." 

A table containing a list of each trouble ticket you 
have submitted, their tracking number, short 
description, and current status appears. 

This concludes the script to exercise the 
Trouble Ticketing Tool 

4.9 EOSView 

Table 4.9. Script to Exercise EOSView  (1 of 2) 
Step Action Response 

1	 Access EOSView by double-clicking on The EOSView Main Window appears on the 
the EOSView icon found on the screen 
Desktop/Workbench 

2	 From the "File" pull-down menu select An EOSView window entitled, "EOSView ­
"Open." Select a file to view, file name filename.hdf" opens containing information about 
must end in ".hdf" Select "OK." the file you selected. 

3	 From the "File" pull-down menu on this A dialog box opens containing information about 
new window select "File Info." Once you the file you have selected. After you click "OK" the 
have read the file information click "OK" to window disappears. 
close the window. 

4	 From the "EOSView - filename.hdf" The name of the file appears in the new window. 
window double-click "File Identifier." 

5	 Select "Close" from the "File" pull-down The window closes. 
menu of this "EOSView - Text Display" 
window. 

6	 Return to the "EOSView - filename.hdf" A new "EOSView - Text Display" window opens 
window and double-click on "File containing a brief description about the file you 
Description." have opened. 
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Table 4.9. Script to Exercise EOSView (2 of 2) 
Step Action Response 

7 Select "Close" from the "File" pull-down 
menu of this "EOSView - Text Display" 
window. 

The window closes. 

8 Return to the "EOSView - filename.hdf" 
window and double-click on "Palette:." 

An informational message appears noting that the 
feature is not implemented 

9 Click on the "OK" to confirm and close the 
message 

The window closes 

10 To view the imagery, click on one of the 
listed "Image (nnn x nnn) ref = n (palette)" 
items. 

A new window appears entitled, "EOSView Image 
Display window - Image (nnn x nnn) ref = n 
(palette)." The image is displayed within the 
window. "Zoom in" and "zoom out" buttons are 
available. A pan window is labeled beneath the 
zoom buttons. 

11 Expand the "EOSView Image Display 
window." Zoom in on the image by using 
the "Zoom In" button. Place the cursor in 
the Pan Window and pan around the 
image. 

The image is displayed at higher resolution and 
can then be moved around by control of the 
panning window to show other portions of the 
zoomed-in image. 

12 From the "Palette" pull-down menu, 
choose the "Select" option and from there 
choose one of the alternate color palettes. 

The image display refreshes using the new color 
palette. 

13 Return to the "File" pull-down menu and 
choose the "Quit" option 

The window closes. 

14 From the "EOSView - filename.hdf" 
window select "Animate Images" from the 
"Options" pull-down menu. 

The images within the file are loaded and 
displayed in a window entitled, "EOSView - Image 
Animation Window - filename.hdf." 

15 Enlarge the new window. Go to the 
"Options" pull-down menu and select 
"Mode." From there select "Continuous 
Run." Move the cursor to the row of 
buttons at the bottom of the window and 
select the ">>" (Play) button. 

The images begin display in an animation loop. 

16 Move the cursor to the speed toggle at the 
bottom left corner. Move the speed toggle 
to maximum speed (+). 

The animation loop increases in speed. 

17 Press the "||" (Stop) button. The animation loop stops. 

18 Go to the EOSView - Main Window and 
select "Exit" from the "File" pull-down 
menu. 

All open EOSView windows will close and 
EOSView will quit. 

This concludes the script to exercise 
EOSView 
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4.10 The User Preference Tool 

Table 4.10. Script to Exercise the User Preference Tool  (1 of 2) 
Step Action Response 

1 Access the User Preference Tool from the 
Desktop/Workbench by double-clicking on 
icon. 

The User Preference Tool will appear in a window. 

2 To view/edit the preferences for a portion 
of the EP6 select one of the buttons on the 
left-hand side of the Tool window. 
the button labeled "Earth Science Search 
Tool" 

The information on the right-hand side of the 
window shows the customizable elements of the 
ESST. 

3 To edit the preferences highlight the 
desired field and type in the new 
preference. 
"Window Startup Position X:" and change 
the default value "222" to "400." 

The new number "400" will appear in the field. 

4 Save the preferences by selecting the 
"Save" option from the "Preferences" pull-
down menu at the top of the window. 

The pull-down menu option "Save" appears and is 
selected. 

5 To view/edit the preferences for the 
Desktop select the button labeled 
"Desktop" on the left-hand side of the 
window. 

The information on the right-hand side of the 
window shows the customizable elements of the 
Desktop. 

6 To edit the preference for WWW browser 
highlight the field labeled, "WWW browser 
path name" and type, "Mosaic" 

The word "Mosaic" should appear in the field. 

7 Change the Experience level by selecting 
the switch and select the option "Expert." 

The toggle switch changes from "Intermediate" to 
the new preference "Expert." 
Experience Level may be changed but it does not 
change any portion of the EP6, it does not affect 
the experience level of interface displayed. 

8 Save the preferences by selecting the 
"Save" option from the "Preferences" pull-
down menu at the top of the window. 

The pull-down menu option "Save" appears and is 
selected. 

9 To edit the preferences within the Product 
Request Tool select the button labeled 
"Product Request Tool" found on the left-
hand side of the window 

The information on the right-hand side of the 
window shows the customizable elements of the 
Product Request Tool. 

10 Select the field "email address" and enter 
in your correct email address. 

The text "none" is replaced by the correct 
information. 

11 Change the default media type by 
selecting the toggle switch labeled, 
"Default Media Type." 
Pull" 

The text "ftp" is replaced by "Network Pull." 

Click on 

Select the field labeled, 

The NOTE: 

Select "Network 
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Table 4.10. Script to Exercise the User Preference Tool (2 of 2) 
Step Action Response 

12 Save the preferences by selecting the 
"Save" option from the "Preferences" pull­
down menu at the top of the window. 

The pull-down menu option "Save" appears and is 
selected. 

13 Quit the User Preference Tool by selecting 
the "Quit" option from the "Preferences" 
pull-down menu at the top of the window 

A Quit Confirmation dialog box will appear. 

14 Confirm the quit action by selecting, "OK." The dialog box will close 

This concludes the script to exercise the 
User Preference Tool 

4.11 The Comment Survey Tool 

Table 4.11. Script to Exercise the Comment Survey Tool (1 of 2) 
Step Action Response 

1	 Access the Comment Survey Tool from the The Comment/Survey appears in the WWW 
Desktop/Workbench by double-clicking on browser window. 
the CST icon 

2	 After reading the introductory text select the The questions relating to the EP6 in general 
"General" icon from the Questionnaire appear. 
Index. 

3	 Answer the survey questions by selecting Numbers are highlighted as they are selected. 
the number in the table that corresponds to 
your agreement or disagreement with each 
question 

4	 Scroll down the page to the field labeled, The text appears in the field 
"Comment, Suggestion, Complaint" and 
enter any comments you have about the 
EP6 in General. 

5	 When the survey form is completed click A Thank You message appears in the WWW 
the "submit" button to send the information browser window. 
to ECS. 

6	 To answer survey questions about other The Comment/Survey appears in the WWW 
portions of the EP6 return to the Comment browser window 
Survey Tool home page by selecting the 
survey icon at the bottom of the page 

7	 Select another portion of the EP6 survey by The questions relating to that portion of the EP6 
clicking on the associated icon appear in the WWW browser window 

8	 Answer the survey questions by selecting Numbers are highlighted as they are selected. 
the number in the table that corresponds to 
your agreement or disagreement with each 
question 

4-14 160-TP-008-001




Table 4.11. Script to Exercise the Comment Survey Tool (2 of 2) 
Step Action Response 

9 Scroll down the page to the field labeled, 
"Comment, Suggestion, Complaint" and 
enter any comments you have about the 
EP6 in General. 

The text appears in the field 

10 When the survey form is completed click 
the "submit" button to send the information 
to ECS. 

A Thank You message appears in the WWW 
browser window. 

11 Repeat steps 7 through 10 until you have 
completed the EP6 survey. 

This concludes the script to exercise the 
Comment Survey Tool 
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